UNIT
[

Excel 2010

Creating é Chart

You can create Excel charts from your worksheet data automatically. In a worksheet, you select the cells that
contain the data you want to chart, then use commands in the Charts group on the Insert tab to specify the
chart type you want to add. Any changes you make to the worksheet data are automatically reflected in the
chart. You can change the chart type to explore different options until you find the type that best illustrates
your data. a First-quarter sales results for the Canoe Kit just became available at Outdoor Designs.
Serena has provided you with a worksheet that shows sales for each month by region. You need to create a
chart based on the worksheet data.

TROUBLE
There are two Line
buttons on the
Insert tab; be sure to
click the one in the
Charts group.

QUICK TIP

 Depending on your
screen resolution,
your vertical (value)
axis might show dif-
ferent values or
number intervals,
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Start Excel, open the file I-1.xisx from where you store your Data Files, then save it as
I-Canoe Kit Sales by Region
e —————

Select the range A4:D8 . :
The range A4:D8 cm data you want to chart. Notice that you selected the row and column labels but
not the column totals. For most charts, you should avoid including totals when selecting worksheet cells.

Click the Insert tab
The Charts group on the Insert tab contains buttons for inserting common types of charts, including Column,
Line, Pie, Bar, Area, and Scatter. The Line chart type is good for showing trends in data over time.

Click the Line button in the Charts group
The Line chart menu opens and displays two subcategories, 2-D Line and 3-D Line. The thumbnails provide a
visual guide for what each chart subtype looks like.

Click the Line option (first thumbnail under 2-D Line), as shown in Figure |-2

Aline chart is inserted into the current worksheet, as shown in Figure I-3. The region names from the work-
sheet are on the chart’s horizontal axis, and sales amounts are on the chart’s vertical axis. Colored lines repre-
senting the sales data for January, February, and March appear in the chart. The double-line border and sizing
handles around the chart indicate that the chart is selected. Notice that the Chart Tools Design, Layout, and
Format tabs are all available on the Ribbon; these contextual tabs become available when a chart is selected.

Click the Change Chart Type button in the Type group on the Chart Tools Design tab

The Change Chart Type dialog box opens. This dialog box lets you apply dozens of different chart types to a
selected chart. The left pane displays each chart category. The Line category is currently selected because the
selected chart is a line chart.

Click the Column category in the left pane, click the Clustered Column option, as shown
in Figure -4, then dlick OK —_—

The chart in the worksheet changes to a clustered column chart, with three data series (blue, red, green)
representing January, February, and March sales for each region. See Figure I-5.

Click the Save button [ on the Quick Access toolbar
The chart is saved as part of the workbook file.

Working with Charts
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I

Excel 2010

Moving and Resizing a Chart
and Chart Qbjects

You can easily move a chart if it obscures your worksheet data, or resize it if it is too large or too small. You
can also move or resize many of the individual components of a chart—sometimes called chart objects—
such as the chart background or the legend. To move a chart object, select it and drag it to a new location.
To resize a chart object, drag one of its sizing handles. Note that some chart objects (such as the chart axis)
cannot be moved and that others (such as the chart title) cannot be resized by dragging. ASEE8 To improve
the overall appearance of the worksheet, you decide to move the chart below the worksheet data and make
it bigger. You also decide to move the legend so that it is aligned with the top edge of the chart.

not to a sizing han-
dle; pointing to a
sizing handle allows
you to resize the
chart rather than

move it.

If you make a mis-
take when moving
or resizing a chart,
click the Undo but-
ton on the Quick
Access toolbar, then

try again.

QUICK TIP
To delete a chart or

chart object, select it,
then press [Delete].

To move a chart, 4
point to an edge but

1. If the chart is not selected, click the chart border to select it
2. Point to the top edge of the chart so that the pointer changes t§ % )drag the
that its upper-left corner is aligned with the upper-left corner of c& , then release the

mouse button
The chart is now directly below the worksheet data. As you dragged the chart, a dimmed image of the chart
moved with the pointer.

3. Scroll down until you can see row 29

Position the pointer over the chart's lower-right sizing handle so that the pointer changes
to ", drag the sizing handle down so that the chart's lower-right corner is aligned with
the lower-right corner of cell H29, as shown in Figure I-6, then release the mouse button
The chart enlarges to the new dimensions. If you drag a corner sizing handle, you increase or decrease a
chart’s height and width simultaneously. To increase or decrease only the height or width of a chart, drag a
side, top, or bottom sizing handle.

5. Click the chart legend

Sizing handles appear arotid the edge of the legend, indicating that it is selected. Note that the sizing handles
on the legend—and on all chart objects—are circular at the legend corners and square on the border midpoints.
This is different from the sizing handles on the chart itself, where they are groups of dots.

6. Point to any border of the legend (but not to a sizing handle) until the pointer changes
to %, then drag the legend up to the position shown in Figure I-7
The legend is now positioned to the right of the upper-right corner of the chart.

7. Save your changes to the worksheet

m Working with Charts
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Applying Chart Layouts
and Styles

When you create a chart, it has default layout and style settings for the chart type applied. A chart layout
is W' such as the legend and chart title. A chart style is a
predefined set of chart colors and fills. Instead of modifying individual chart elements, such as moving the
legend or changing the Color of a data series, you can instantly change the way chart elements are positioned
and whether certain elements are displayed or hidden by choosing a different layout. Chart layouts are
available from the Chart Layouts gallery on the Chart Tools Design tab. You can change fill colors and
textures by choosing a chart style from the Chart Styles group on the Chart Tools Design tab. You can also
get a different view of your data by reversing the rows and columns. ﬁ You decide to experiment by
switching the rows and columns of the chart to see the effect. You also want to improve the appearance of
your chart by applying a different chart layout and style.

QUICK TIP
The Chart Tools
Design tab is a con-
textual tab; it is
available only when
a chart is selected.

1. Click the Chart ToolgDesign tab, if necessary
The Chart Tools Design tab displays commands for changing the appearance of a chart.

2. Click the Switch Row/Column buiton in the Data group

See Figure I-8. The chart now shows only three clusters of data series (instead of the original four), one for
each month. Each data series now represents the revenue for each region (instead of each month), so there are
four data points for each cluster instead of three. The horizontal axis labels now list the three months of the
first quarter (instead of the regions). This view of the data shows more clearly the overall growth trend for

“~_each month.

3. Click the More button [=]in the Chart Layouts group :
The Chart Layout gallery displays an assortment of thumbnails of different layouts. Some have gridlines, some
have data labels, and a few have chart and axis titles. You want a layout that has a chart title and axis titles.

4. Click Layout 9 (third layout in third row)
~ Your chart now Tras placeholder text for a chart title, a vertical axis title, and a horizontal axis title. You need
to replace the placeholder text for these titles with appropriate text for your chart.

'\—‘-
5. Click Chart Title, then type Q1 Canoe Kit Sales by Region, then press [Enter]

When you click the
Chart Title place-
holder and type text
for your chart title,
 notice that the text
you type appears
only in the formula
bar (not in the Chart
Title placeholder).
This can be confus-
ing, but don't be
alarmed—the chart
title text will

appear when you
press [Enter].

The title “Q1 Canoe Kit Sales by Region” appears above the chart. You can also edit chart titles and axis titles
using the formula bar.

6. Click.Axis Title jn the vertical axis, type Sales, then press [Enter]
The vertical axis label now reads “Sales,” clarifying that each data series represents sales figures.

7. Click Axis Title in the horizontal axis, type Month, then press [Enter]
The horizontal axis label changes to “Month.” The chart and axis titles make it easier to interpret the
meaning of the chart. Compare your screen to Figure I-9.

8. Click[=]in the Chart Styles group, click Style 26 (second style in fourth row), then save
your changes
The new style is applied to the chart, as shown in Figure I-10. This style has a three-dimensional appearance
and makes your chart more visually appealing.

Working with Charts
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Excel 2010

Customizing Chart Objects

When you create a chart, each chart object has default layout settings applied. For instance, the clustered
column chart with- the chart layout you applied positions the chart title above the chart and positions the
legend to the right of the chart. You can easily change the positioning and attributes of individual chart
objects by choosing from additional preset options on the Chart Tools Layout tab, or by making custom
choices in the Format dialog box. Chart elements that can be modified include the chart title, axis titles,
legend, data labels, axes, gridlines, plot area, and data table. A data table in a chart s a grid containing the
chart's underlying worksheet data, which is added below the x-axis in certain types of charts. “ You
decide to position the chart title so that it is inside the plot area. You also want to position the legend at the
bottom of the chart to make more room for the data series, and change the orientation of the vertical-axis
title so that it is easier to read. You also decide to explore other options to improve the chart’s appearance.

QUICK TIP

A trendline is a line
that connects high
or low points in a
data series and

.| shows a trend. To

in the Analysis
group, then click
an option.

Format di 0x
is available for every
chart object and
offers many options
beyond the presets
available on the
Ribbon. To open the
dialog box for any
chart object, right-
click it, then click

o,

1. Click the Chart Tools! Layoutjtab
The Chart Tools fayout Tab contains buttons and commands for changing the layout of a selected chart. You
use this tab to work with individual chart elements. .

2. Click the Chart Title button in the Labels group, then click Centered Overlay Title
The chart fitle is now positioned in the chart just above the largest data series. This arrangement increases the
size of the plot area without requiring you to enlarge the chart.

dd a trendii S ; . . . . . .
3har§ tcﬁffkﬁli;?.;e P> 3. Click Axis Titles in the Labels group, point to_Primary Vertical Axis Title, then click

izontal Title

See Figure I-11. The vertical axis title changes from a vertical to a horizontal position.

_\_\\
QUICK TIP

4. Right-click the legend, click Format Legend, click the Bottom option button in the Format
Legend dialog box, as shown in Figure 1-12, then click Close~

The legend now appears below the chart, and the chart expands to fill the empty space on the right.

5. Click the Data Labels button in the Labels group, then click Qutside End
Labels for each worksheet value in cells BS through D8 now appear above each data marker. Unfortunately, the
values are too big to fit in the chart and the labels overlap, making them look cluttered and difficult to read.

6. Click the Data Labels button in the Labels group, then click None
Ty

Format [object].
The data labels are removed.
7. Click the Gridlines button in the Axes group, point tq_Primary Vertical Gridlines, then click
jor Gridlines
' Vertical gridlines now appear in the chart, enclosing the monthly sales for each region. This effect helps to
visually separate each region’s monthly sales.
f___—’\___\

QUICK TIP
Data tables are help-
ful when your chart
contains data from
another worksheet
or location.

8. Click the Data Table button in the Labels group, then click W
\—\—h_______.___—

See Figure I-13. A data table is inserted, with a legend in the first column that identifies the data series in each
row. Data tables are helpful when you want to show both the chart and the underlying worksheet data.
Because this worksheet already contains the data for the chart, you don't need the data table here; it makes

the worksheet look cluttered.

9. Click the Data Table button in the Labels group, click None, then save your changes
- _
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m effects to the chart and axis titles to make the chart more visually appealing.

1. Click the Toqls tab

The Chart Tools Format tab is act €. You can apply special styles and effects to selected chart objects using
the Format dialog box or the Chart Tools Format tab.

2. Click any one of the urple Northeast data markers in the chart
Sizing handles and a border suround all the data markers in tHe Northeast data series, Clicking a single data

marker selects all the data markers in that series, You decide to change the selected data series color to orange.

3. Click the Format Selection button in t’lP—CthtenLSeLe;ﬂoLgMp on the Chart Tools

Format tab

The Format Data Series dialog box opens, providing options you can select to enhance and change the
appearance of the selected data marker. You need to adjust the Fill setting,

QUICK TIP
To select a single
data marker,
double-click the
data marker.

QUICK TIP
You can open the
Format dialog box
for any chart object
from either the
Layout tab or the
Format tab.

4, Click_ Fill in-the left Pane under Series Options, click the Solid fill option button; click the
Color list arrow, click the Qrange, Accent 6 color, as shown in Figure -T2 tharelick Close

The Format Data Series dialog box closes, and the Northeast data series color is now orange.

TROUBLE
If you have trouble

locating tl?e Chart ;
5:23&;;3;'55@'%32 5. Click the Chart Elements list arrow in the Current Selection group, cli then
Format Selection click the More button [=in the Shape Styles gallery

button in the
Current Selection
group; the text
Series "Northeast”

The Shape Styles gallery displays several shape styles that you can apply to the selected chart title,

6. Click th - e, as shown in Figure I-15

?hgﬁ'd&e displayed The chart title is now formatted with a three-dimensional blue background and white font. You decide to add
'ETemim T;;x_ a shadow special effect so that the title matches the style of the data serjes,

QUICK TIP
To remove format-
ting that you have
applied to a chart
object, select the
object, then click the
Reset to Match Style
button in the
Current Selection
group on the Chart
Tools Format tab,

7. Click the e Effects button in the Shape Styles group, point to Shadow, then click the
Offset Bottom style in the Outer category

The chart title now has a shadow along its bottom edge, enhancing the impression that it is three
dimensional.

8. Click the vertical axis title (Sales), then click the - te in the
_Shape Styles gallery |

9. Click the @@mm&wmﬁnmmmw style in the

Shape Styles gallery, then save the worksheet
Compare your screen to Figure I-16.

m Working with Charts
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Creating a Pie Chart /.«
atin art g
reating a Pie Chart ~ /.-l
Column charts are great for comparing values across categories, but they are not very useful for comparing
percentages or parts to a whole. For instance, the column chart does not convey the West region’s
percentage of total first-quarig?sales. A pie chart is an effective tool for comparing the relative values of
parts to a whole. Just like any other type of chart, you can add it to a worksheet, or you can add it on a
separate chart sheet. A chart sheet is a sheet in a workbook that contains only a chart; it contains no

worksheet cells. .ﬂ Serena wants you to create a pie chart on a separate chart sheet that compares
total first-quarter revenues of the Canoe Kit by region.

UNIT
[

Excel 2010

1. Select the range A5:A8, press and hold [Ctrl], then select the range E5:E8

You selected two nonadjacent ranges (the region names and total first-quarter sales for each region); this is the
only worksheet data you want reflected in the pie chart. You want to create a pie chart that shows each
region’s percentage of total sales.

2. Click the Insert tab, click the Pie button in the Charts group on the Insert tab, then click
‘—\____-__—__-ﬁ ‘

the Pie in 3-D opti ) g
See Figure I-17. A 3D-style pie chart now appears in the worksheet and covers part of the column chart. The
pie chart shows that the purple pie wedge (representing the Northeast region) is slightly bigger than the ¢

others, and the blue pie wedge (representing the West region) is the smallest. You decide to move the pie chart

to a new chart sheet in the workbook, so that it can be viewed separately from the column chart. ¢
. L
3. Click the Move Chart button in the Location group on the Chart Tools Design tab
The Move Chart dialog box opens.. é
4. Click the New sheef option button, type Q1 Canoe Kit Sales % in the New sheet text box L
You can pull out, or as shown in Figure I-18, then click OK ~ I 0
explode, 2 pie slice The pie chart moves to a new chart sheet called “Q1 Canoe Kit Sales %", '
from a pie chart to g

emphasize a particu-
lar value. Click the
pie chart, click a pie
slice, then drag it
away from the pie.

k./ . "
5. Click the More button |z] in the Chart Layouts group, then click Layout 1
Each pe slice in the chart now contains a label for the region and for the region’s percentage of total sales. A
chart title placeholder is displayed above the chart. ‘

PN

e

6. Click the Chart Title placeholder, type Q1 Canoe Kit Sales by Region, then press [Enter]

To add text to a

|t f;‘;g:the 7. Click Northeast on the purple pie slice, notice that the labels on all the slices are now {
tab, click the Text selected; right-click the pie slice (
]BO" tt_’”m”;; click the The Mini toolbar and a shortcut menu open. You can use the Mini toolbar to apply formatting to selected text
ocation wnere you .
want to add the or objects. ¢

text, then type your
desired text. Format 8. Click the Increase Font Size button |A’| on the Mini toolbar seven times to increase the

i

e iaiean font size to 20, click the File tab, then click Print )
Mini toolbar or A preview of the chart sheet is displayed in the preview area in Backstage view. Notice that the orientation is ’
Home tab. set to Landscape, the default setting for chart sheets. Compare your screen to Figure I-19. /\ ¢

9. Click the Home tab, then save your changes 6 T F 0 )
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Creating Sparklines

In addition to charts, you can aEMmmunicate patterns or trends visually.
Sparklines are tiny charts that fit in one cell and illustrate trends in selected cells. There are three types of
sparklines you can add to a worksheet. A line sparkline is a miniature line chart that is ideal for showing a
trend over a period of time. A column sparkline is a tiny column chart that includes a bar for each cell in
a selected range. A win/loss sparkline shows only two types of bars: one for gains and one for losses.
Table I-2 provides descriptions and example of sparkline types. You should place sparklines close to the cells
containing the data they illustrate. H You decide to create sparklines next to your worksheet data to

m illustrate sales trends in the quarter for each of the regions.

1. Click the Sheet1 sheet tab, click the Insert tab, then click cell F5

(CEll k>
This is where you need to insert a sparkline for the Tange B5:D5, the data series for the West region sales from
January to March.

2. Click the Line button in the Sparklines group
The Create Sparklines dialog box opens. You need to select the cells for which you want to create a sparkline:

the range B5:DS. /@6‘% e ,{;{'0(’(

TROUBLE
If the Create
Sparklines dialog
box is blocking the

range you want to 3. Select the range BS:DS, compare your screen to Figure I-20, then click OK
select, drag it out of : : . ;
the way, Cell F5 now contains a sparkline that starts in the bottom left of the cell and slants upward to the upper right

comer, indicating an increase from cell BS to C5 to D5, At a glance, the sparkline communicates that sales

increased steadily from January to March. You can add markers on the line to indicate values for each cell in
the selected range,

4. Click theMarkers check box in the Show group

The sparkline now displays three sma]lvsquare markers. The left marker represents the West Iegion’s January
sales (BS), the middle marker represents the West region’s February sales (CS), and the far-right marker
represents the West region’s March sales {E5). You want to change the sparkline to a different color,

5. Click the Mare hutton []in the Style group, then click Style 12 (last style in second row)

‘The sparkline color is now red, and the sparkline markers are black,

To change the color
of sparklines or spar-
kline markers for
selected cells, click
the Sparkline Color
arrow or the Marker
Color arrow in the
Style group, then
click the color

you want.

To change the spar-
kline type to either

column or win/loss,
select the cells con-
taining the sparkline,

6. Drag the cell ESfill handle to cell F9
Cells F6:F9 now contain red sparklines with black markers that show sales trends for the other regions, as well
as the total sales, as shown in Figure I-21. Notice that the sparkline in cell F7 shows a downward trend from
the second to third marker. All other sparklines show an upward direction. You can see how sparklines make

i ; :
Ehjﬂr;:l;lmn o It easy to see at a glance the sales performance of each region for the quarter.
the Win/Loss button .
in the Type group. 7. Enter your name in cell A2, then save your changes

9
TROUBLE 8. Click the File tab, click Print, preview the worksheet, close the worksheet, exit Excel, then
If the chart is : ¢
selected when you submit your completed worksheet to your instructor
preview the work-
sheet in Backstage
view, only the chart Wl (

will appear in the \
Preview pane. Click % NV {
any cell in the work- A\S v {'

sheet outside of the K{ \ N \ [ k

chart to preview \

andjor print the ) N U\
worksheet with O

the chart.
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Select the best answer from the list of choices.

14. Which of the following axis titles would most likely be shown on a vertical axis in a chart?

15.

16.

17.

18.

a. Years ¢. Months

b. Costs d. Countries

In a chart, a sequence of related numbers that shows a trend is called a(n)

a. legend C. axis

b. data marker d. data series

You just finished a 10-week math class, in which you had a quiz every week. You want to create a chart
that shows each quiz score for each week. Which of the following charts would NOT be a good choice for
your chart?

a. Pie chart ¢. Column chart

b. Bar chart d. Line chart

Which of the following tabs on the Ribbon do you use to add a chart title?

a. Chart Tools Design tab ¢. Chart Tools Format tab

b. Chart Tools Layout tab d. Insert tab

Where should you place a sparkline in a worksheet?

a, In a chart below its underlying data

b. In a separate chart sheet, away from its underlying data

¢. Inasingle cell adjacent to the cells containing its underlying data
d. In a group of cells below its underlying data

Skills Review

1.

Understand and plan a chart.

a. Open the filefl-2xlsx from where you store your Data Files, then save it as I-Recycling Revenue,

b. Examine the worksheet data, then consider what Excel chart types would best present this type of information.
¢. Is the worksheet designed in such a way that it will be easy to create a chart? Why or why not?

. Create a chart.

a. Select the range A4:D9.

b. Display the tab on the Ribbon that contains commands for inserting charts.
¢. Insert a 3-D Clustered Column chart,

d. Save your changes to the workbook.

- Move and resize a chart and chart objects.

a. Drag the chart so that the upper-left corner of the chart is aligned with the upper-left corner of cell A12,

b. Use the lower-right corner sizing handle to align the lower-right corner of the chart with the lower-right corner of
cell G28.

¢. Move the legend so that its top edge aligns with the top of the tallest data marker in the chart.

d. Save your changes.

. Apply chart layouts and styles.

a. Open the Chart Tools Design tab, if necessary.

b. Use a button on the Design tab to reverse the columns and rows and get a different view of the data. Examine the chart
and identify what new meaning this new structure conveys.

Apply the Layout 3 chart layout to the chart.

- Replace the placeholder chart title with Recycling Revenue, 2011-2013.

Apply Style 26 chart style to the chart.

Save your changes.

e e

- Customize chart objects.

a. Display the Chart Tools Layout tab.
b. Add a horizontal-axis title to the chart. Replace the placeholder axis title with Years.
C. Add a vertical-axis title that is rotated. Replace the placeholder axis title with Revenue,

Working with Charts m
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Skills Review (continued)
d. Add major gridlines for the vertical axis.

| ;
IT e. Save your changes.
6. Enhance a chart.
f a. Display the Chart Tools Format tab.
[ b. Select one of the West data markers in the chart,
5 ¢. Open the Format Data Series dialog box.
' d. In the Format Data Series dialog box, select the Fil] categofy, specify a solid fill, choose Orange, Accent 6 from the
Color palette, then close the dialog box.

€. Use the Chart Elements list arrow to select the chart title, then apply the Moderate Effect - Orange, Accent 6

i shape style.

f. Apply the Offset Top Shadow shape effect to the title,
8- Apply the Moderate Effect — Orange, Accent 6 shape style to the vertical-axis title and the horizontal-axis title.
h. Save your changes.
7. Create a pie chart.
a. Select cells A5:A9, then press and hold [Ctr]] while selecting ceIls/, ES——E\9
b. Insert a pie chart, choosing the Exploded piein 3-D option. - ’
¢. Move the pie chart to a new sheet in the workbook. 0

GURE I-23 7
Name the sheet Revenue by Region.
d. Apply the Layout 6 chart layout to the chart.
€. Increase the font size of the percentage amounts on Recycling Enterprises, inc.
the pie slices to 24. ﬂ;&mw*s%ﬁwwmmJ%m
f. Click the chart title placeholder, type Recycling —— : it

Revenue by Region, 2011-2013, then
press [Enter].
8- Save your changes.
8. Create sparklines.
a. Click the Sheet1 sheet tab to return to the worksheet.
b. Add a line sparkline to cell F5 that is based on the
data range B5:D5.
C. Specify to add data markers to the Sparkline,
- Apply Style 31 to the sparkline.
€. Use the fill handle to copy the sparkline in cell F5 to
the range F6:F10.

f. Enter your name in cell A30. Save your changes. s ;

8. Preview the worksheet in Print Preview, Change the  FIGUREKZs  /
scaling settings to Fit Sheet on One Page, then save ' g
your changes. View the chart sheet in Print Preview,
Close the workbook, exit Excel, then submit your
completed workbook to your instructor. Compare

your completed worksheet and chart sheet to
Figures 1-23 and [-24.

a

I Recycling Revenue by Region, 2011-2013

\/’
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Independent Challenge 1

You work for a landscaping services company called Landscapes for Good Living, located in the midwest. The company offers
landscaping services, including brick paving, landscape design, sodding and seeding, landscape lighting, and irrigation. Frank
Langdon, the general manager, has created a worksheet that contains revenue data for the five categories of services that the
company offers. He has asked you to create a chart using the worksheet data to show the results for each quarter.

a. Open the ﬁ§?}dsx from where you store your Data Files, then save it as I-Landscape Revenue.
b. Create a stake( area chart based on the data in the range A4:E9.
C. Move the chart so that it is positioned directly below the worksheet data, then enlarge it so that the bottom-right cor-
ner of the chart is aligned with cell G30.
. Switch the rows and columns, so that May, June, July, and August are on the x-axis.
- Apply the Layout 3 chart layout to the chart, then apply a chart style that you like.
Replace the placeholder chart title with Revenue, May-August.
. Add a rotated vertical-axis title Revenue. Add a horizontal-axis title with the text Months. Apply a shape style that
you like to the vertical and horizontal axis titles. '
- Apply a shape style that you like to the chart title, .
i. Add line sparklines to the range GS5:G10. Include markers in the sparklines. Apply a sparkline style of your choosing to
the sparklines.
jo Create a 2-D Exploded pie chart by selecting the noncontiguous ranges A5:A9 and F5:F9. Move the pie chart to a sepa-
rate chart sheet named Revenue by Service Type. Apply the Layout 2 chart layout to the pie chart. Change the
chart title to Revenue by Service Type. Increase the font size of the percentage amount labels on each pie slice
to 20. ; :
k. Open Sheetl, then type your name in cell A32. Format the worksheet data and worksheet title using fonts, font sizes,
borders, alignments, and shading to make the worksheet look professional and easy to understand. Choose formatting
options that are complementary to the colors and style of the chart.

L. Preview the Sheet1 worksheet in Print Preview. Change th(ﬂ;?ﬁtﬁ’ﬁ?s to Fit Sheet on One Page, then save your
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changes. Figure I-25 shows one possible solution for FIGUAE 1.25 y

the worksheet and chart. . — .

: i _~"Landscapes for Good Living, Inc. i
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B Open the Revenue by Service Type chart sheet. -

m Click one of the data labels on the pie chart
(such as 10%) to select all the data labels.

E Click the Chart Tools Format tab, click the More
button i7|in the WordArt Styles group, then click
the Fill - White, Drop Shadow style.

B Right-click the legend, then click the Increase
Font Size button on the Mini toolbar four times
to increase the legend font to 14.

®  Click the Chart Tools Layout tab, click the Text
Box button, click in the lower right corner of the
chart sheet, then type your name.

$90,456 §95934 | $250987 | 5277800
575,874 $98,567 | 5145765 | $371,157
$48,765 $65,345 | 596,542 | $231,630
543,763

m. View the chart sheet in Print Preview. Close the BrckPaing aL Desgn  mSoddiogBSesing  wlandscapelightng  «lmigation ||
workbook, exit Excel, then submit your completed ' ' :
workbook to your instructor.

Your Name
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Independent Challenge 2

You work for Thelma Watson, the general manager of an online bakery retailer. Thelma has created an Fxcel worksheet show-
ing product sales for June and the revenue generated by each product category. She has asked you to create a chart in the work-
sheet that shows the percentage of total sales each category represents.

a. Open the file I-4.xIsx from where your Data Files are located, then save it as I-June Product Sales.

b. Create a pie chart using the data in the range A4:B9. Choose the Pie in 3-D style,

¢. Move the chart below the worksheet data.

d. Resize the chart so that its lower-right corner is aligned with the lower-right corner of cell G29.

e. Change the value in cell B9 (the number of pies sold) to 5,275. Observe the change in the chart.

f. Apply the Layout 1 chart layout to the chart. Apply a chart style that you like.

8. Display the Chart Tools Layout tab, then use the Chart Elements list box to select the Chart Area. Click the Format
Selection button in the Current Selection group to open the Format Chart Area dialog box. Select Fill, then specify to
add a solid fill, choosing settings in the dialog box that you think will look good. Experiment by choosing different
settings, then close the dialog box to view the settings. Repeat this process until you are satisfied with how the chart
area looks.

h. Increase the size of the labels and percentage amounts in each pie slice to 12.

i. Format the worksheet data and worksheet title using fonts, font sizes, borders, alignments, and shading to make the
worksheet look professional, visually pleasing, and easy to understand. Choose formatting options that are comple-
mentary to the colors and style of the chart. Make any other formatting enhancements to the chart and to the work-
sheet data to make it attractive and more professional looking. Enter your name in cell A31 in the worksheet.

jo Preview the worksheet and chart in Print Preview. Close the workbook, exit Excel, then submit your completed work-
book to your instructor.

Independent Challenge 3

You work for Stephen Briggs, the manager of an art gallery. In September, the gallery opened an exhibit of paintings from a
private collector that included never-before-seen masterpieces by several famous artists. Museum attendance increased
dramatically in that month due to the high public interest in the exhibit and a strong marketing campaign. Stephen is
preparing to meet with the museum’s board of directors to discuss the increased attendance. He has asked you to create a
chart that shows the number of people who visited the museum from May through September. He also needs the chart to
show a breakdown of children, adults, and seniors who attended. The data you need to create the chart has already been put
into a worksheet,

a. Open the fil g sx from where you store your Data Files, then save it as I-Gallery Visitors. Enter your name in
cell A9.

b. Create a 2D line chart of all three customer categories during the months May through September. Choose the 2-D Line
with Markers chart type. Choose a chart style that you like.

¢. Move the chart to a new chart sheet in the workbook. Name the chart sheet Gallery Visitors May-Sept.

d. Apply the Layout 9 chart layout to the chart. Change the chart title to Gallery Visitors, May-Sept.

e. Add minor vertical gridlines to the chart. Add an appropriate vertical-axis title that is rotated, then add an appropriate
horizontal-axis title. ‘

f. Apply a solid color fill to the plot area, choosing a color you think looks good. (Hint: To select the plot area, open the
Layout or Format tab, click the Chart Elements list arrow in the Current Selection group, and click Plot Area, Then
open the Format Plot Area dialog box and specify a fill color.)

Warking with Charts _
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8- Apply a shape style of your choosing to the chart FIGURE [-26
title and axis titles, Figure I-26 shows one possible
example of the completed chart,

i a]ieryvisiiars, Moay-Sapt
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Advanced Challenge Exercise

, B Switch to the Sheet1 worksheet that contains the
chart data. Enter Trend in cell H3. Notice that
the label you entered is formatted like the labe]
in cell G3.

B Click cell H4, click the Insert tab, click the
Column button in the Sparklines group, select
the range B4:F4, then click OK. Notice the
column sparkline that appears in H4.

B Use the £ill handle in cell H4 to copy the column
sparkline in H4 to the range H5:h7,

h. Save your changes, preview the worksheet and chart
sheet, close the workbook, then exit Excel. Submit your completed workbook to your instructor,

RealLHelndependentChaHenge

Creating a personal budget is a great way to keep your finances in order. In this Real Life Independent Challenge, you will cre-
ate a personal budget for monthly expenses. For the purposes of this exercise, imagine that you earn $2,500 per month. Your
budget needs to include Categories of expenses and the amounts for each expense. The tota] €xpenses in the worksheet must
add up to $2,500. Once Yyou enter all your monthly expenses in the worksheet, you will then create a pie chart that shows the
percentage of each individua] expense.
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. Enter the following labels for the éxpenses in cells A4:A12: Housing, Utilities, Car Payment, Insurance,
Student Loans, Food, Entertainment, Gas, Savings.
ch expense in cells B4:B12.
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data; y the heading row, the labels, and €xpense amounts.) Choose any pie chart option that you like, Move
the chart so that it is Jocated below the worksheet data.

h. Apply a chart layout and chart style that you like. If the chart layout that you choose does not include a chart title, add
one to the chart using the appropriate options on the Chart Layout tab. Replace the chart title placeholder with the
title My Monthly Expenses,

1. Save your changes, Preview the worksheet with the chart, close the file, then exit Excel. Submit your completed
workbook to your instructor.
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Visual Workshop

Open the Data File isx, then save it as I-Charity Challenge Results where you store your Data Files. Make format-
ting changes to the WefTksheet so that it looks like Figure [-27, then add the two charts so that they match the figure, using the
commands and techniques you learned in this unit and previous units. You will need to make formatting changes to both charts
so that they match the figure. Entér your name in cell A3 as shown. (Hint: You will need to merge and center the ranges ALGl,
A2:G2, and A3:G3 so that the tompany name, worksheet title, and your name match the figure.) Save your changes, preview the
d charts, close the file, then exit Excel, Submit your completed workbook to your instructor.

-

Haskell-Barnes Insura nce, Inc.

Employee Charity Challenge Results
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